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Starting the system

Turing the PC on
① Turn on the PC.
② Log on Windows with your own user ID.

Wait until desktop appears.

③ Switch on the central power.
Laser controller 
④ Rotate the start key and Switch on the 

main power of each laser. 
Touch Panel Controller（TPC)
⑤ Press the main switch of the touch panel 

controller.

Starting software
⑥ Double-click the [cellSens FV] icon on 

the desktop.
※Start the software after 
“Start operation” is displayed on TPC.

⑦ The dialog box appears. Set each 
checkbox and click [OK].

【Factory Default ID & password】
Factory User ID：evident
Password：evident

Switch on the 
main power

Rotate 
start key

④Laser Combiner

TPC main 
switch

⑤Touch Panel Controller（TPC)

Selection whether or not to initialize the resonant 
scanner

Selection whether or not to control the XY stage 
by software.

XY stage type

Selection whether or not to move to XY stage origin.
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Controller／Objective lens

Brightness 
adjustment for 

DIA
The

focusing nob.

※TPC: Controller:
Software:
All the same meaning.
Use something that is easy to use.

（See the page 7 of this operation manual 
uses TPC. )

How to use the immersion objective lens
① Set the immersion objective lens in the optical 

path.
② As shown in the figure on the left, Drop 

immersion oil on the objective lens.
（1 or 2 drops）

③ Set  the specimen and adjust the focus with the 
focus handle.

※Please note that images will be difficult to see if 
bubbles enter the oil.
※Please use the immersion oil suitable for the 
objective lens.
※Clean the objective lens and specimen after use.

[a]Adjustment of Objective Correction collar

① Rotate the correction collar (   ) very slightly and 
re-focus the objective to determine if the image 
has improved or degrade. 

② Repeat the previous step.
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The fluorescence 
observation(EPI)

The transmitted DIC 
observation(DIA)

Shutter (Open/Close)

Select the mirror unit 
in the [Cube turret]

Changing the ND filter during 
fluorescence observation. 

Ocular     



Observation via eyepieces

★Fluorescence
＊ Select the objective lens on the TPC.

① Click “Ocular” in [Ocular] Tool window.

② Click “EPI”.

③ Select the cube.

④ Click “Open” in EPI Shutter.
After observation, click “Close”

⑤ Excitation light power can be adjusted 
by ”EPI Lamp”.

⑥ .

★DIC (Transmitted light)
＊Select the objective lens on the TPC.

① Click “Ocular” in [Ocular] Tool window.

② Click “DIA”.

③ Adjust the brightness via slider in 
Trans Lamp.
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①
②

③

※Display may differ depending 
on the configuration. 

★After observation via eyes, click “LSM”

②

④
③

①

⑤



① Select “Standard” in [Detector Setting] tool 
window.

Assign the FL probe and Ch

② Click 
③ Click 
④ Double click the FL probes to observe。
⑤ When registering the FL probes, TD channel is 

registered automatically. If you don’t need the 
channel, double click TD to remove.

⑥ Click OK after selecting all channels.

Adjusting the live image
⑦ When you acquire multiple channel image, 

selecting “Line” in sequential scan is 
recommended.  。

⑧ Click any one of following                       .
Adjust focus and Laser Intensity. (HV and Offset on
TD.)

⑨ Use “Average” or “Accumulate” to get better S/N.
⑩ Adjust LUT via                     or vertical bar on 

the right.

XY Image Acquisition(1)

①

Variable confocal aperture

②

③

④

⑤

⑥

⑦

⑧

Laser Intensity

Sensitivity of TD 

Variable detection wavelength
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XY Image Acquisition（２）
Setting the scanner in [LSM Imaging]
⑩ Select the type of scanner and mode.
⑪ Set “Scan Size” and “Aspect Ratio”.
⑫ Set “Zoom” and “Rotation”.

Clicking “Optimize”, Zoom changes to make 
pixel size to ½ of optical resolution.
⑬ Set “Speed”. S/N will be better with slower 
speed.
* 1us/pixel will be available only when scan 
size is lager than 1024x1024.

Starting Acquisition 
⑭Select [Normal] tab in [Acquire] Tool Window.

Press the      button to open the dialog.

*The acquired images are saved automatically.
Series number is added at the end of file 
name  like “×××_0001” and “×××_0002”.

⑮ Press the button to start acquiring 
the image.
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⑩

⑬
⑪

⑫

⑮

⑭

Final check
 DO NOT use “％”  to the file name.
 Setting such as Timelapse, Z stack, etc. 

are recognized via icons. 



Virtual Channel Scan
acquiring multiple CH image whose channel 
number is lager than the number of detector

① Select “Standard” in [Detector Setting] tool 
window.

Assigning the detector to channel
② Press the  button on [Detector 

Setting] Tool Window.
③ Press the             button to reset the 

Assigned Dye.
④ Double-click the name of fluorescence dye 

to observe.
⑤ Press the            button to add the phase.   
⑥ Drag & drop the “Dye” to observation 

channel list of the phase you want to add. 
⑦ After setting all channels, press the [OK] 

button .

Adjusting the live image
⑧ Press                 or             to switch phase.
⑨ Adjust the acquisition setting. Refer the 

previous pages.
⑩ Set “XYZ” and “XYT” setting. Refer the 

following pages.

Setting Acquisition
⑪  Select [Normal] tab in [Acquire] Tool

Window.
Press the      button to open the dialog.

*The acquired images are saved automatically.
Series number is added at the end of file 
name  like “×××_0001” and “×××_0002”.

⑮ Press the button to start acquiring 
the image
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③

⑤④

⑦

⑧
②



XYZ Image Acquisition(Start/End)
＊Before starting the following procedure, adjust 
for XY imaging.

Setting Z series
① Select “ON” in [Z] on [Series] Tool Window. 
② Select “Start/End” in [Motor] on [Z section].

Register Start/End position
③ Change the Z position by the focusing knob.

Press the              button in [Start] at the Z 
position to start acquiring the image .

④ Change the Z position and press the 
button in [End] at the Z position to 

end acquiring the image.
⑤ Enter a value [Slices] or [Step Size].

Setting one will set other automatically.
Pressing the             button, both numerical 
values “Slice” and “Step Size” are optimized.

Setting Acquisition
⑥ Select [Normal] tab in [Acquire] Tool Window.

Press        to display the dialog box, then 
select the folder to save the image.

⑦ Press the                 button to start acquiring 
the image .

Finishing Acquisition
⑧ Finishing acquisition,                 buttons blink.

Press the                 to finalize the image 
acquisition. If you want additional images 
from end position, enter the number of 
additional acquisition and press the 

.
After acquiring, press the                .   

Press the              button, current position 
is set as 0.00. 
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①

③

⑤

②

④

Reset: Reset to initial values.

⑥

⑦

⑧

⑥



XYZ Image Acquisition(Range)

＊Before starting the following procedure, adjust 
for XY imaging.

Setting the Z-series
① Select “ON” in [Z] in [Series]tool window.
② Select [Range] in [Motor] on [▼Z Section]

Register the Range
③ Change the focus and click             at the 

center of the specimen.
④ Enter the Range.

Slices and Step size setting
⑤ Click            to enter the optimize value of 

Slices and Step size.

Setting Acquisition
⑥ Select [Normal] tab in [Acquire] Tool Window.

Press        to display the dialog box, then 
select the folder to save the image. 

⑦ Press the                 button to start acquiring 
the image .

Finishing Acquisition
⑧ Finishing acquisition,                 buttons blink .

＊ Press the                 to finalize the image 
acquisition. If you want additional images from 
end position, enter the number of additional 
acquisition and press the 

.
After acquiring, press the 

①

③

⑤

②

④

⑥

⑦

⑧

⑥
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Reset: Reset to initial values.



Bright Z
scanning  while correcting the brightness against the Z position
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This function cannot be used with Virtual Z

＊Before setting the following, adjust XY 
image setting and Z stack condition. 
① Select [Tool Window]＞[BrightZ] .
② Select “ON” on ”During Z-series” in 

[BrightZ] tool window.
(Select “ON” on ”During manual Z” to 
activate Bright Z during changing focus 
manually.）

Registering value.
③ Move to start Z position and show Live 

image.
④ Click              in [BrightZ] tool window to 

register the parameter. 
⑤ Change the focus and change the laser 

intensity along the depth, click          
each time change the parameters.

⑥ Repeat ⑤ until the end Z position.
⑦ Acquire as same way of XYZ.

⑤ ⑧

When this is on, Bright Z is available 
while changing focus manually.

CHs are switchable to see 
the registered parameters 

②

Intensity of selected wavelength can be shifted。
e.g.
Registered as 0.1%、1.5%、5% at 488nm.
Enter 5% then click “Shift” , re-registered as
5.1%、6.5%、10%.



XYT Image Acquisition
＊Before starting the following procedure, 
make adjustments for XY imaging.(refer to 
page 8-9) 

Setting Time Series
① Select ”ON” in [Time] on [Series ] Tool 

Window.
② Set the interval to acquire the image  in 

[Interval] and [Cycle] on [Time Lapse].

Starting Acquisition
③ Select [Normal] tab in [Acquire] Tool 

Window. Press the     button to 
display the dialog box, and select the 
folder to save images.
*The acquire images are saved 
automatically. Series number is added at 
the end of file name like “***_001”and 
“***_002”.

④ Press the                button to  start 
acquiring the image.

Finishing Acquisition
⑤ Finishing acquisition,               button 

blink.

＊Press the              button to complete 
the image acquisition. If you want to 
Additional images under the same 
condition, enter the number of additional 
acquisition and press the               button.
After the image is acquired, press the

button.

If you attempt to set the shorter than the time 
displayed in [Scan] in [Interval], “FreeRun” 
appears. In this case, the interval to acquire the 
image is the time displayed in [scan].
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①

②

③

④

⑤



Exiting the system

Exiting the software and PC
① Close the software.
② Shut down the Windows.

Turning OFF the power
Touch Panel Controller（TPC)
③ Tap the “OFF” on display of TPC.
④ Then press the TPC main switch .

※Do not long-press the main switch.

Laser controller
⑤ Turn the laser combiner to OFF.

※Rotate start key of the power.
Supply and set the switch to OFF.

Central power 
⑥ Turn off the central power.

＊When using immersion oil , clean the 
objective lens.

Rotate the Key

Turn to 
OFF

⑤Laser unit

④TPC main 
switch

Touch Panel Controller（TPC)

③Touch 
the “OFF”

⑦Central 
power
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２D view and operation
Drawing scale bar and ROI
• A straight line can be drawn by pressing Shift key when left-clicking.

Scale barROI

Set the range 
of animation

play Frame rate

Playing animation of the series images
• These button are used to play animation of the series images.
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LUT (Look Up Table)
• Click         and adjust LUT or color , etc.

• Adjust LUT by using vertical bar or 

Colors

CH 
selection

Intensity or Photon number

①
③

③

③



3D view and operation(1)
Opening the file and displaying 3D image
Open and activate the Z series image.
Select [Volume] tab to display 3D image.
Drag the mouse on the 3D image in the 
direction you want to rotate.

■Zooming 3D image
Mouse wheel :Zooms toward the center of the 

3D image displayed. 
Shift key＋mouse wheel : Zooms in the display 

area

■3D image setting
Select the                        button and select 
[Volume setting] in [Tools window] menu.
[Volume setting] Tool Window is displayed.
Select [View] tab in [Volume setting].   

■Selecting the algorithm
[Algorithm]：The field is used to express the 3D
image from following 3 types.

１）MIP：Maximum Intensity Projection
The MIP method reflects the maximum intensity 
of the object preferentially on the image.
Therefore ,the context of the object is not taken 
in account, and the area with  the high intensity 
even in the object can be extracted.

２）Isosurface
The Isosurface method draws the area where 
the intensity variation volume of the object is 
large as a top surface and reflects it on the 
image. Therefore, only the top surface is drawn.

３）AlphaBlend
The α blend method reflects the intensity on the 
top surface of the object preferentially to the 
image.
Therefore , the context of the object is displayed 
properly.

Ticking this checkbox will 
display Wire Cube in 3D 
view.
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Observe the cross section.
(cf. next page）

■Save the 3D image
①Right click of the 
mouse on the 3D image 
and 
select “ Save Display”.

②Input the File Name 
and Format.

③Click the [OK] button.



3D view and operation（２）
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■Clipping/Cut
Displays the yellow frame in the image 
constructed in 3D.
Dragging this frame with the mouse will display 
only the area visible from the frame.

■Clip and cut
Show “clipping” and “cut” at the same time.
changing the cross collection XY/YZ/XZ by 
pressing these button.

■Slice
Create the  cross-sectional view sliced in 
XY/XZ/YZ directions in the image constructed 
in 3D image, and displays the image sliced in 
each direction.
The cross sections can be moved by dragging 
the mouse.

＊SliceXZ/YZ/XY
After setting the position and angle eith Slice, 
switch to “SliceXZ” ,”SliceYZ” or “SliceXY”, the 
cross section of the position determined in Slice 
is displayed. 

Clipping

Cut

Slice

SliceXZ

Clip and Cut



Creating the movie
＊Opening the file and displaying 3D image

① Press the                   button and select 
[Volume setting] in the [Tool Window] 
menu.  

② Select [movie] tab in [Volume setting] tool 
window. 

③ Select “Key Frame” in [Movie Item]

④ Press the            button.
“Sequence1” is shown below “Key Frame”. 
Select  “Sequence1”in [Movie Item].

Registering the Key Frame
⑤ Move the 3D image in [Image] Window by 

dragging and right-click at the desired 
status.
When you select [Add Key Frame] in the 
menu display, the display status is 
registered and “Key Frame X” is displayed 
in [Id] in [Volume setting] Tool window.

⑥ Repeat ⑤ and register the statuses you 
want to display as Key Frames.

⑦ When you press the          button, the 
image between Key Frame is interpolated 
automatically to play back the movie.

Exporting movie
⑧ Select “Sequence xx” in [Movie Item] and 

select the movie you want to export.
Press the            button.

⑨ Press the         button to select the folder 
of the save destination.
Set the [File name] and [Frame rate] by 
entering them directly.

⑩ Press the        button.

①

⑤

⑨

20⑩

②
③

④
⑥

⑦

⑧

⑤



Projection(1)
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① Click        to show projection image。

② File > Save As > Projection Image OR 
right-click on the image > Save As > 
Projection Image.

③ Save the image (.OIR is the extension 
only available)

①



Projection(2)

① Press the                       button to switch 
to “Viewer mode”.

② Select [Analysis] in the [Tool Window] 
menu. 

③ Select “Single process” and “Post 
processing” as the illustration below.

④ Select the [Processing] tab and resister 
“projection” in [Processing Item].

⑤ Click the [Input], and select the images 
for image processing.

⑥ Select “MAX” in [Mode] in [Processing 
Property]. 

⑦ Press the              button. 

⑧ The image processing results are 
displayed in [Image] window, and saved 
to the same location where the original 
imaged were saved. 

③

④

⑤

⑥

⑦

①②
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① Select [Analysis] in the Tool window menu.
② Select the ROI tool in [Analysis ROI], and specify the area you want to 

measure on the item.
③ Select “Single process” and “Post processing”.
④ Select the [Graph] tab, and Select [Series Analysis] , and press the

button.
⑤ Click the [Input], and select the images for image processing.
⑥ Set details of items in [▼basic] in [Property].

⑦ Press the         button allows you to draw all graphs 
registered in [Graph List].

▼[Graph] tab
・You can change the color in [Line] tab. 
・Press the              button to save the graph. 

▼[Table] tab
・Press the         button to save the results as

CSV file.

・Apply All Frame Range→Yes（Measuring for all frames）
 No（Measuring for specified frame）

・Apply All Channel→Yes（Measuring for all channels）
No（Measuring for selected channels）

①

⑦

②
③

④

⑤

⑥

⑧

Drawing a Intensity Graph
：Series Analysis

(Specifying ROI on the series image)



① Select [Analysis] in the Tool window menu.
② Select the ROI tool in [Analysis ROI], and specify the area you want to 

measure on the item.
③ Select “Single process” and “1D profile”.
④ Select the [Graph] tab, and Select [Series Analysis] , and press the

button.
⑤ Click the [Input], and select the images for image processing.
⑥ Set details of items in [▼basic] in [Property].

⑦ Press the         button, [Graph] tab and [Table] tab
appears.

▼[Graph] tab
・You can change the color in [Line] tab. 
・Press the              button to save the graph. 

Drawing average intensity profile：
1D profile

（the arbitrary line viewing the series image ）
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①

⑦

②
③

④

⑤

⑥

⑦・Apply All Frame Range→Yes（Measuring for all frames）
 No（Measuring for specified frame）

・Apply All Channel→Yes（Measuring for all channels）
No（Measuring for selected channels）



Exporting the image

A. Exporting a single image
① Right-click on the image to be exported.

Select [Export] in the menu displayed.
The [Export] dialog box appears.

② The save destination of the image to be 
displayed in ②.
If necessary, press the       button to 
select the folder of the save destination.

③ Set the file name and select the file type 
in [Save as type].  

④ Select the channel to be  exported in 
[CH/Range].

⑤ Set the range to be exported and the 
number of steps in ⑤．

⑥ Set whether or not to overlay the ROI 
over the image to be exported.

⑦ When general purpose format is selected 
in [Save as type], select the method to 
export channels and the bit color.

⑧ Ticking this checkbox will output the 
properties in the text.

⑨ Press the             button. 
The image will be exported.

B. Exporting Multiple images
⑩ In the [File] menu on the software screen, 

select [export multiple files].
 The [Export multiple files] dialog box
appears.

⑪ Select the method to export images. 
⑫ Press the       button to select the folder 

or the file to be exported.
⑬ Select the save destination and the file 

format to be exported in [Save as Type].
⑭ Same as 4~8 of A.
⑮ Press the             button. The image will 

be exported.

①

②

③

⑥

⑦

⑧

⑨

⑪folder/file

Save destination
File format

ROI

Format

⑮save

⑫

⑬
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*the image can be exported in the file format which 
can be used by other software.

④

⑤



Reloading and 
saving Observation Method

Save/ load the observation method
① Select the [Observation Method] in [Tool 

Window] menu.
＊Each function

:to load the observation condition 
selected in the list

  :to save the current condition and    
 add the list

  :to update the current conditions

:to delete the condition from the list

:to sort the list

:to import/export the methods

Click the acquiring condition
① Press the         button and open sub pane.

② Select [Property] tab and check the 
acquiring conditions.

Load acquisition parameters from 
acquired image

*Read actual acquisition condition from the 
image and reflect them in the software setting

・In [Property] in sub pane, press the

button.

①

Direct input by 
double-click

①
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Configuration

■Changing the objective lens
＊Exchange the objective lens to be used.
① Select [Configuration] in [Tool] menu.

The [Configuration] dialog box appears.
② Select [Microscope] tab.
③ Select [Objective Lens]. 
④ Select the name of the mounted 

objective lens.
⑤ Specify the optical elements to be 

switched by interlocking during the 
switchover  of the objective lens.

＊Select the DIC which is same number as the 
objective lens.
 example）30X→IX2-DIC30
 100X→IX2-DIC100

⑥ Press the         button.

■Specifying the micro plate
① Select [Configuration] in [Tools] menu.

The [Configuration] dialog box appears.
② Select [Preference] tab.
③ Select [Plate].
④ Select the micro plate to be used.
⑤ Press the         button.

■For Z drift compensation
① Select  [Configuration] in [Tools] menu.

The [Configuration] dialog box appears.
② Select [Microscope] tab.
③ Select [ZDC] tab.
④ Specify the coverslip type to be used.
⑤ Enter directly the thickness of the 

coverslip to be used.
⑥ If you use the DIC, tick the check box ⑥．
⑦ Press the        button.

①

②
③

④ ⑤

⑥

②

③
④

②

③
④

⑤
⑥

⑤

⑦



ZDC
※Option
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Maintain Focus with the Z-Drift 
Compensation(ZDC) system

■ZDC（Z Drift Compensator ）
The ZDC uses minimally-phototoxic infrared light to identify the 
location of the sample plane.
ZDC makes it easy to reproduce any preset focus position.
It avoid focus drift due to temperature changes or additional of reagents.
The ZDC is also compatible with silicone objective and plastic bottom 
vessels.

■Objective lens for ZDC2

Objective lens
Glass bottom dish（t=0.17mm） Plastic dish（t=1.0mm）

Continuous One shot Continuous One shot

Dry

UPLXAPO4X × × - -

UPLXAPO10X ○ ○ - -

UPLXAPO20X ○ ○ - -

UPLXAPO40X ○ ○ - -

Long
working 
distance

UCPLFLN20X ○ ○ ○ ○

LUCPLFLN20X ○ ○ ○ ○

LUCPLFLN40X ○ ○ × ○

LUCPLFLN60X ○ ○ × ○

silicone

UPSAPO30XS ○ ○ - -

UPLSAPO40XS ○ ○ - -

UPLSAPO60XS ○ ○ - -

UPLSAPO100XS ○ ○ - -

oil
UPLXAPO60XO ○ ○ - -

UPLXAPO100XO ○ ○ - -

PLAPON60XOSC ○ ○ - -

water UPLSAPO60XW ○ ○ - -
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Configuration :ZDC
① Select [Configuration] in [Tools] menu. The [Configuration] dialog box 

appears.
② Select [Microscope] tab.
③ Select [ZDC] tab.

④ Press the [OK] button.

■Near Limit
① Select [Microscope] in [Tool Window].
② In [▼Z limit Setting], set the Near limit to all objective lenses.

:set the current Z coordinate  as a 
Near limit

:register the  adjusted position as a
Near limit

30

Coverslip type（Glass / Plastic）

Coverslip thickness

Use DIC observation
（Objective lens:100X）
Tick→The DIC prism is placed in the light path
Uncheck→without the DIC prism in the light path

If there setting are not made correctly, 
the autofocus may not work properly.

This field is used to set the material 
of coverslip you will use.

ZDC in MATL
This field is used to select the timing to 
execute the ZDC when acquiring the image by 
MATL

If the Near limit is not set properly,
the autofocus may be failed.
Recommended value
：focus position＋500μm



XYT Image Acquisition
(with the Z drift compensation)

＊In advance, prepare to use ZDC. 
（See page15 for details. ） 
＊Set for acquiring the series image.
Setting near limit
① Select [Microscope] in [Tool Window] 

menu.
Press the                                  button to 
set the Near limit to all objective lenses in
[▼Z limit Setting].

② Set [ZDC DM] in [ZDC Control] on 
[Microscope] Tool Window to “In”.

③ Specify the search zone of the coverslip 
position in [Upper Limit] / [Lower Limit] 
in [Search Zone] .

④ Set [ZDC during series scan] to "ON".
⑤ Adjust focus and press the               

button .The coverslip top surface position 
is acquired. 
When the Z drift compensation is 
successful, the buzzer sounds beeps once 
only. If the Z drift compensation is not 
successful, the buzzer sound beeps three 
times.

⑥ When performing the Z drift 
compensation continuously during series 
scan, press the                            button 
in [Continuous ZDC] .
As this function performs the drift 
compensation in real-time during series 
scan, the focusing can be at a high-speed.

⑦ Press                 in [Normal] tab in 
[Acquire] Tool Window to start acquisition.

・High-speed scanning→Continuous AF
・If the rest time is longer than 30 seconds 
→You had better not use Continuous AF

【Attention】
If [Rest] is shorter than 31 seconds, Z drift 
correction works only first scanning. For every 
time working, set the [Interval] so that the 
[Rest] to be 31sec or longer. 

◆ZDC◆
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ZDC setting

②
③

④

⑤

⑥



Mortorized Stage
*Option



Option : Motorized stage
◆only for motorized 

stage ◆
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 Multi Area Time Lapse

• Register multiple areas and repeatedly acquire 
images .

• It is also possible to set the interval.
• Time lapse date of multiple area can be acquired 

at once.
 Acquiring stitched image

• Acquire the adjacent area in order.
And stitch the image to create a single wide 
field of view image.

 Map image
• Display wide field of view image acquire with low 

magnification objective lens.
• And it can be used as a guide when looking for the 

field of view.
★Double-click on the map image, the motorized stage 
moves so that it becomes 
the center of the image.

Position１

Position２

Position３

Position４



Multi Area Time Lapse
Imaging Acquisition

＊Before starting the following procedure,
make adjustments for XY imaging.

① Press the        button in [Live] Window.
② Select the [Map] sub pane.

Registering the group of MATL
③ Move the specimen to a desired position 

and adjust the live image. If you want to 
acquiring the XYZ image, make 
adjustments for Z series additionally.

④ Press the       button to register the 
position and its image acquisition condition.

⑤ Repeat the operation of ③ and ④ to 
register for multi area timelapse.

⑥ Set the interval to acquire the image in 
[Interval] and [Cycle] on [Repeat Setting].

⑦ Select [MATL] tab in [Acquire] Tool 
Window.

⑧ Press the       button to display the dialog 
box, and select the folder to save the 
images.

⑨ Press         button to start acquiring the 
image.

①

②

④

⑦

⑧
⑨

⑤

◆Only for 
Motorized stage◆
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【Attention】
All acquiring conditions(XY position, focus position, 
laser intensity, sensitivity, series setting, and so on. 
) are registered when you press the         button. So, 
Register after you finish adjusting all conditions. 



Multi Area Time lapse
using Map Image (1)

＊Before starting the following procedure, 
make adjustments for XY imaging.

① Press the  button in [Live Window], 
the sub pane appears.

② Select [Map] tab.

Create the map
③ Bring the image into focus and adjust 

acquiring parameters using the low 
magnification objective lens.

④ Press the        button to register the 
position and acquiring parameters.

⑤ Scroll to the right in registered are List 
and Ticking [Overlay Map].

Map image acquisition
⑥ Select [Acquire] Tool Window in [Tool 

Window] menu and select [MATL] tab.
⑦ Press the       button to display the 

dialog box, and select the folder to save 
the images.

⑧ Press        button to start acquiring the 
image. Finishing the acquisition, map 
image is displayed in [Map] tab.

【Attention】
All parameters register by pressing the
button. When acquiring a map image, Check
[LSM] in [Series] Tool Window whether it is
selected “OFF” [Z] and [Time] .

①

②
③

④

Scroll to the right

⑥
⑦⑧

◆Only for motorized 
stage ◆
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⑤

Check when automatic processing
→ : Select matching reference frame 



Registering the multiple area
① Set the higher magnification objective 

lens. double-clicking on the map image, 
the stage is moved to at the center of the 
map.

② Press the       to register the position and 
acquiring parameters.

③ Repeat ①, ② register the multi areas
that you want to acquire images.

④ Check the registered area List whether it 
is ticked to ”Enable” at the area which you 
want acquire images.

⑤ If necessary, set [Cycle interval] and 
[Cycle].

⑥ Select [MATL] tab in [Acquire] Tool 
Window.

⑦ Press the        button to display the dialog 
box, and select the folder to save the 
images.

⑧ Press         button to start acquiring the 
image.

⑨ Finishing the acquisition, map image is 
displayed in [Map] tab.

Multi Area Time lapse
using Map Image(2)

【Attention】
All acquiring conditions(XY position, focus
position, laser intensity, sensitivity, series
setting, and so on. ) are registered when
you press the        button. So, Register
after you finish adjusting all conditions.

Clear the Map Image

Delete registered area

①

②

④

◆Only for 
motorized stage◆

If you want to see the image on map 
in real-time, tick the “OverlayMap”. 

36

⑤



Multi Area Time Lapse
(with the Z drift compensation)

＊Before starting the following procedure,
make adjustments for XY imaging.
ZDC setting (See page 24 for details.)
① In [▼Z Limit Setting], press the     

button to set the Near 
limit to all objective lenses.

② Set [ZDC DM] to “In” and place the 
dichroic mirror of ZDC in the light path.

③ Specify the search zone of the coverslip 
position in [Upper Limit] / [Lower Limit] 
in [Search Zone] using the Origin 
coordinate of Z as a base point.

④ Set [ZDC during series scan] to "ON".
⑤ Adjust focus and Press the 

button of [Coverslip position]. The 
coverslip top surface position is acquired.

*When the Z drift compensation is 
successful, the buzzer sounds beeps once 
only. If the Z drift compensation is not 
successful, the buzzer sound beeps three 
times.

⑥ Press the       button to register areas.
⑦ Set [Cycle interval] and [Cycle].

⑧ Select [MATL] tab in [Acquire] Tool 
Window.

⑨ Press the       button to display the dialog 
box, and select the folder to save the 
images.

⑪ Press         button to start acquiring the
image.

◆ZDC◆

⑦

⑨

⑩

⑪
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②
③

④

⑤

⑥

*Update the setting of ZDC position

◆only for 
mechanical stage ◆



Overlap section at tiling imaging

① Select [configuration] in [Tools] to 
open the dialog on the left.

② Select [XY stage] in the [Preference] 
tub.

③ Enter the number directly in “Overlap 
section at tiling imaging”
＊example↓
Objective lens 10X or less:20%～30%

   10X or more:15%～20％

④ Press the [OK] button.
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～Setting of automatic 
stitching process～

Matching/Smoothing : On
→→ Enables matching and 
smoothing processing even 
during automatic stitching.
(* V2.5.1 ~) 



Acquiring the stitched image 
using Map Image(1)

① Before starting the following 
procedure, make adjustment for XY 
imaging. 

② Setting the acquiring area.

＊3 types
A. Register the Column×Row

1. Press the      in area registration.
The [Define Matrix] dialog box is 
appears.

2. Enter the number of Column and Row.
3. Press the [OK]. 

※This button registers an area with the 
center being the stage position at the 
time the button is pressed.  

B. Drawing a rectangular ROI in the 
Map
1. Refer to page 19-20, create a map 

image.
2. Press the     button.
3. Drawing a rectangular ROI in the Map 

image display area, and then registered 
on the list.

C. Drawing a polygonal ROI in the Map
1. Refer to page 19-20, create a map 

image.
2. Press the   button.
3. Drawing a polygonal ROI in the Map 

image display area.
4. Right click of the mouse to complete the 

ROI, and then registered on the list. 

②

A.
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B.

C.

③,④

⑤



Processing to stitch after acquiring 
the image.
① Open the image.
② Press the       button.

The [Stitch Dialog box] appears.
③ After the image is displayed in the 

dialog box, press the           button.

③ Check the registered area List 
whether it is ticked to “Enable” at 
the area which you want acquire 
images. 

④ If you want to see the image on 
map in real-time, tick the 
“OverlayMap”.

⑤ If necessary, set [Cycle interval] 
and [Cycle]. 

⑥ Select [MATL] tab in [Acquire]  
Tool Window.

⑦ Press the      button to display the 
dialog box, and select the folder to 
save the images.

⑧ Press the       button to start 
acquiring the image.
Finishing the acquisition, map 
image is displayed in [Map] tab.

Acquiring the stitched image 
using Map Image(2)

40

⑤



Stitching
① Open the date you acquired.

② Click on the top left of the image in 
the Map tub to select all image.
And then click the      button.

③ Stich window is displayed. In a few 
seconds, preview image is displayed.
※Too large date takes time to display 
the preview image.
※Since the images are arranged side 
by side without consideration of 
margin, they are displayed in a 
duplicate state as shown in the figure.

④ Select the processing content.

⑤ Press the            button to start 
stitching.

⑥ The name of the date after stitching 
is 「Stitch_***」.

★In case of the large date
・If it exceeds 1GB, the file is divided.

File name :「Original file name_00001（serial number）」
＊please note that images can not be opened when there are no 
divided file. 

 ・there are restrictions on export. Please use “Resize”.

How to open the image after closing the image. 
1)Select File>Open>MATL
2)Select the folder. And open「matl.omp2info]
3)After open the file, subpanel is opened. And select 
the Map tub automatically.

*Matching→Correct overlapping parts
*Smoothing→Make 
the boundary smoother, making it less 
noticeable.
*Resize→Reduce the image.

②

③

④

⑤

-10-



Adjusting the tilt in Z direction
～Focus Map～

① Before starting the following 
procedure, make adjustment for XY 
imaging.

② Setting the acquiring area (more 
than 2X2).（p.39）

③ Click the        button .
The Red focus point is displayed at 3 
positions in MATL ROI.
※If necessary, drag&drop the focus 
point on the map image display area 
to change the XY position of the 
focus point.
※Moving the XY stage position of 
the focus point moves the XY stage 
moves in conjunction with it.

④ Click the Red frame to turn it Green. 
Right-click on the green frame to 
perform [Move to the center of this 
area].

⑤ Adjust the Z position, and click the   
button in the state of the green 

frame.
The Z position of the focus point is 
updated.

⑥ Repeat ④,⑤ at 3 positions.
⑦ Click the   button again.

Then the focus point is disappeared. 
⑧ Start acquiring MATL. 

【Adjustment method】

③
⑦

④

⑤

Offset the origin position in 
each field using the surface 

(focus map) calculated from 
3 focus points.⇒
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Setting of the Well Plate

■Setting
① Select [Tools]＞[Configuration].
② Select the [Preference] tub .
③ Select the [Plate] on the left list.
③ Select the appropriate well.

※Corning is preset.
④ Press the         button.

Register plate in Custom plate setting
（ex：circle well）
Plate name
Well shape：circle or square
Number of column：Lateral well(line）
Number of row：Vertical well(column）
Well diameter
Well spacing：distance between the center of 

the well

■Stage：IX3-SSU
→Center plate must be set.
① Select [Tools]＞[Configuration].
② Select the [Microscope]tub in the window.
③ Select [center plate] on the left list.
④ Select ”IX3-HOW” (well plate holder).
⑤ Press the         button.
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②
③

④



Calibration of the well plate
＊Before starting the following procedure, 
make adjustment for XY imaging.

Set the Map mode
① Select [Live] window. And select the

button to display the tool on the 
left side of the LIVE image.

② Double click the [Map] tub.

Performing the calibration
③ Press the [Calibration] button ,and then 

the Position adjustment mode is 
displayed in the Map Image display area.

④ Select the well to be adjusted in the 
[row] and [column]
(ex)A01 well :（[row]=A, [column]=1）

⑤ Press the [Move] button to move the 
stage for the center of the well to be 
adjusted.

⑥ Press the button to scan the 
Image with the marker displayed.

⑦ Moving the stage so that the edge of 
the well coincide with the cross marker.

⑧ Press the [Register] button at matching 
point.(P1)

⑨ Repeat ⑦ and ⑧ to register P2 and P3 
point.

⑩ Press the [Move] button to move the 
center of the well .
Make  sure that the well center is set 
correctly. If it is not set correctly, clear 
the registration of P1,P2,P3 by pressing 
[Clear] button and register again.

⑪ Press the [Calibration] button again to 
release the Position adjustment mode.

①

②
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③

④ ⑤

⑧

Attention！
As a result of registering P1, P2, P3, if you can not calculate a circle 
from the 3 points (eg 2 points out of 3 points or all 3 points are 
collinear), an error message will be displayed .
In that case, please try again from P1 registration.

⑩

⑪

Please confirm！
Visually check the position of objective 
lens if the well you moved in ⑤ matches 
the well specified with ④ (ex:A1).

When they do not match, move the 
motorized stage to the specified well 
using a joystick.



Map Image display area 
for well plate(1)

When selecting plate type in [Plate], it is 
displayed for microplate.

Pattern diagram for well plate
① Line is alphabet , column is number.

：well  in the stage operation range
click   →selected
double click →move to center of the well

：well where the stage located

：well selected

： Well set as an image selection area and 
further setting that area to “Enable”.

Duplicate the well set as and image 
selection area
① Right click on the well to open the menu.

・Copy acquisition settings of the well
・Paste acquisition settings of the well
・Delete acquisition settings of the well
・Select All Wells in the plate 

② Select “Paste” on the target well

※Dragging on the wells to select the 
Multiple wells.
Yellow frame means selected wells.
It is possible to paste it there.

①
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①Copy ②Paste

②-※Paste（Multiple wrell）



Map Image display area 
for well plate(2)
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Copy and Paste of the scan setting of the one well
• Target row and column can se selected by clicking on row/column nuber.
• All the wells can be selected by context short cut key.

1. Select one column 1. Select all wells 

2. Paste 2. Paste 2. Paste 

1. Select one row

Color labeling of well
• Newly registered (not copied from other well) wells are labeled with different color.
• If one of these well is copied to other wells, they have same color label.

Different setting in eack well Setting of D9 was paste to all wells in rowD Same setting in each row



Registration of Image 
Acquisition area 

① Select the [LSM Imaging] in [Area 
Registration] on [Map] tab.

② Register the Image acquisition area.

A.Specify any area

1. Press the     button to resister an area 
with the stage position at the time the 
button is pressed.

B.Resister the ColumnXRow

1. Press the      in area registration.
The [Define Matrix] dialog box is 
appears.

2. Enter the number of Column and Row.
3. Press the [OK]. 

※This button registers an area with the 
center being the stage position at the 
time the button is pressed.  

C. Drawing a rectangular ROI in the Map
1. Press the     button.
2. Drawing a rectangular ROI in the Map 

image display area, and then registered 
on the list.

D.Drawing a polygonal ROI in the Map
1. Press the   button.
2. Drawing a polygonal ROI in the Map 

image display area.
3. Right click of the mouse to complete the 

ROI, and then registered on the list. 

E.Register all areas of the well
1. Press the       button.

B.

C. D.

①

②

A.

E.
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Advanced

48



Stimulation
Condition setting
① Select the [LSM Stimulation] in [Tool Window] 

menu.
② Select the ROI and resister the stimulation area 

on the Image.

③ select the laser wavelength for stimulation and 
adjust the intensity.

④ Set the speed (us/pixel).
⑤ Remove the check of the [Continuous] and 

enter the time of duration and unit of time.
※Continuous : in case of setting the Start/Stop of 
stimulation manually.

Creating a Time Line
① Select the [Synchronization].
② Select the “LSM Imaging” in [Base Method].

（＝Start TimeLine simultaneously with image 
capture.）

③ Select “OFF” in [Rest in stimulation].
※ON:Image capture continues even during light 
stimulation.

④ Enter the wait Frame: from Image acquisition to 
start stimulation.

Set the T series(Total number of the frame)

① Select “ON” in [Time] on [Series] tool window.
② Set the interval to acquire the image in 

[Interval] and [Cycle] on [▼Time Lapse].
Execution of TimeLine
① Select [Sync] tab in [Acquire] window.

Press the button to display the dialog box, 
and select the folder to save the images. 

② Press the button to start acquiring 
the image. 

①
②

③

④

⑤

①
②

③

④

①

②

③

Tornado scan
A:trnado scan at a constant angular velocity with a circle. 
L:trnado scan at a constant linear velocity with a circle.
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※Recommendation
Laser ND Filter=None

※When changing the Mode of scanner, ROI is reset.
To specify the ROI, display the LIVE image once,



Stimulation

Drawing the graph of brightness with 
LIVE image
① Select the[Live Graph] in the [Tool window] 

menu.

② Specifying the place checked the intensity by 
drawing the ROI in [Analysis ROI].

③ Ticking these checkboxes displays the intensity 
profile.

④ To change the color, double-click the displayed 
color. When the        button appears, click it to 
display a dialog box.

⑤ change the color in the box.
⑥ Press the button to start imaging and 

drawing the intensity graph.
⑦ Right click on the graph and select the 

[SaveDisplay] to save the image of the graph.

①

②

③

When drawing and analyzing a luminance graph after image acquisition
→ refer to p.22 “Creating a luminance graph: Series Analysis”
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Super Resolution:FV-OSR
The resolution can be improved to around 120 nm by using FV-OSR.

① Adjusting focus and set Laser Intensity(%), Sensitivity(HV), Gain and Offset 
on [PMT setting] Tool Window.

② Select the [Super-resolution] in the [Tool Window].
③ When "Super-resolution imaging" is turned on, the following items are set 

automatically.

④ Remove the DIC slider from the light path and set ZDC DM to “Out” in the 
“Microscope” window.
（It affect the image quality.）

⑤ Adjust the focus and brightness again.
※ Because the high magnification zoom is applied, please be careful about 

fading.
⑥  It is also possible to combine Z stack .
⑦ ”scan counts” is used to set the cumulative number when acquiring the 

super-resolution image. （Recommendation：2-8 times）

⑧ Select the folder and set the name of the image. Press the              button.

■Following parameters are set automatically
・Scanner：Galvano / Oneway
・Pinhole size

→The image will be darker because it is squeezed smaller.
・Zoom

→Lager scan size leads lager field of view. 

■High contrast mode
→ON: High contrast mode 
 OFF: Standard mode

■Noise Reduction
→The noise is reduced while acquiring the 
super-resolution image and it is saved as an 
image different from the super-resolution image. 
（Recommendation：Strength10-40）

③

⑦

⑧

※OSR 
license
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Append Images

① Select the [Analysis] in the [Tool window] 
menu.

② Select the [Single process] and [Post 
processing] in the [Analysis] tool window.

③ Open the [Processing] tab.
④ Select “Append Images” in the [▼Edit 

Images].
⑤ Click the [Input], and select the image for 

image processing.

⑥ Select the axis for series to connect images 
when adding the image in “Dimension” and 
select the image to be added in “Append 
Series”.

⑦ Press the           button.

①

②

④

⑦

⑥

③

⑤
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① Select the [Analysis] in the [Tool window] 
menu.

② Select the [Single process] and [Post 
processing] in the [Analysis] tool window.

③ Open the [Processing] tab.
④ Select “Extraction” in the [▼Edit Images].
⑤ Click the [Input], and select the image for 

image processing.

⑥ Setting the value of item in the [Processing 
Property].

⑦ Press the           button.

①
②

③

④

⑤

⑥

⑦

Extraction
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i. Setting the interval among frames (ex: 1 )

ii. Setting the section to extract the image from 
the series image.
(ex:2~4→2…4 )
※For 「… 」, use the one entered on the 
software from the beginning.

iii. Select the channel to extract the image.
“All” allows you to extract all channels.



① Select the [Analysis] in the [Tool window] 
menu.

② Select the [Single process] and [Post 
processing] in the [Analysis] tool window.

③ Open the [Processing] tab.
④ Select “Merge Channels” in the [▼Edit 

Images].
⑤ Click the [Input], and select the image for 

image processing.

⑥ Select the different image and channel to be 
composed in the [Processing Property].

⑦ Press the           button.

Merge Channels

③

②①

④

⑤

⑥

⑦
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Colocalization
～cellSens～

① Open the Image on FV software and Right-click to select [Send to cellSens].
② cellSens starts up.
③ Select the [Colocalization] .(Measure>Colocalization)
④ Select the two color channel on which you want to perform the measurement colocalization.
⑤ In the target area group, select the target range of the analysis.
⑥ Select the “Threshold” in [Mode] and select the “B(upper right) in the Use quarter.
⑦ In the scatterplot, define the intensity range.
⑧ In the preview, the pixels whose intensity  values are within the quandrant that has been selected 

are shown in white.
⑨ Click the [OK] button to finish the measurement of colocalization.
⑩ Numerical date can be output with the [File>Export to >Excel].

■Tips of setting the threshold
①Select the [View]>[ToolWindow]>[Colocalization]
②Adjust the brightness and Backgroung with [Adjust Display] to see the signal.
③the optimized number of threshold is “Right” in Fixed scaling.

■Result
Peason’s Correlation Coefficient
Overlap Coefficient
Colocalization Coefficient 
Total amount of pixels
Selected pixels and % of A~D

①

④

⑤
⑦

⑧

⑨

⑥
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3D Deconvolution
～cellSens~

①

① Open the acquired Image (Z stack) and double click on the image. Select the [Send to CellSens].
② cellSens is displayed.
③ Select the [Process]>[Deconvolution]>[Constrained Iterative…].
④ Choosing images for the deconvolution filter in “Apply on”.(All frame… or Selected frames… )
⑤ Press the                 button.
⑥ Choose the “Laser Scanning Confocal” or “FLUOVIEW FV3000” in Modality.
⑦ Set the Algorithm and parameters.

⑧ Press the                 button to start the process.
（press the                button to display a preview of the resulting image.）

■Enough resolution is required for successful the Deconvolution

ex）In case of use the 60xO Objective lens (NA1.3）
・ImageSize : more than 800x800
・Zoom : more than 1.5X
・Z Step size : less than 3um
・Z Slice : the more slices, the better. 

⑤

④ ⑥

⑦

⑧

※Option : cellSens 3D Deconvolution
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TruAI Noise Reduction
High S/N image will be expected by using AI noise reduction.

① Open the images.
② Show Analysis tool window by Tool Window > Analysis.
③ Select [Single process] and [Post processing] then select [TruAI Noise 

Reduction] in Processing Item.

④ Select the image in [Input].
Choose “Add Channel” or “New Image” in [Output Type]. 。

⑤ Start by [Process].

※FV40S-
AINR option
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■Available condition
→Select the [Single process] and [Post 
Processing] in the [Analysis] tool window.

① Select the [Single process] and [Post 
processing].

② Select the [Batch] tab.

③ Press the [Add] to display the dialog box.

④ Specify the folder or file to be processed.

⑤ If there is an unnecessary image, delete it 
with [Remove].
※when the date is selected , image and 
acquisition condition are displayed.

⑥ Press the [Select] to specify the location 
folder.

⑦ Select the [Processing] tab and return to the 
processing menu selection.

⑧ Select the process to be performed, a list is 
added to “Input/Output setting”.

⑨ Click the [Input], and select the [BATCH].

⑩ Press the          button.

※Only the file processed last remains.
If you  check the image after processing , 
please reopen the file.

BATCH：
Batch processing for multiple images

②

①

③

⑤

⑦

⑨

⑥
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① Select the [Analysis] in the [Tool window] 
menu. And select the [Single process] and 
[Post processing].

② Select the [BATCH] tab.

③ Press the [Add] to display the dialog box.
④ Select the folder that tiling was acquired.
⑤ Press the [Select] to open the dialog box. 

And specify the folder to save/

⑥ Open the [Processing] tab.
⑦ Select “projection” in the [▼Edit Images].

⑧ Click the [Input], and select the [BATCH]. 

⑨ Press the           button.

⑩ Select File>Open>[MATL] to open the 
folder, and select ”***.omp2info”.

⑪ Press the        and select [Map] tab.

⑫ Press the       to display the image 
processed.
(Not displayed when the number of tiling is 
large) 
Confirm that the image is displayed, then 
press           to execute the process.

Stitching after projection
: For large volumes of date, time can be reduced.

②

①

③

⑤

⑦

⑧

⑨
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Sequence Manager
（making protocol of acquiring）

①

②、③

④(drag)

Making the protcol
① Select the [Sequence Manager] in 

[Tool Window] menu.
② Press the button in [Add task] to add 

the task.
※before adding the task, make 
adjustments for setting. 

Acquiring the XYZT

Imaging and the light
stimulation

A light stimulation

Wait or Pause

→Pause：stops the protocol that is 
running until you press the      button
→Wait: stop the protocol that is 
running until the time specified in 
[wait time].

③ Resister the Loop task
1．Selecting a task registered in the 
protocol to repeat the selected task.

2．Press the   button.

3．Sspecify the repeat count in [Loop 
setting] dialog box.

④ Move the task 
select the task and drag .

Execute the protocol
① Select the [Sequence] in the [Acquire] 

window.
② Select the folder to save image and file 

name.

③ Press the button.
→the protocol are resistered to the 
system

④ Press the  button.

  The running protocols are paused.

The running protocols are stopped.

①

②

③ ④

↑Loop↑delete the selected task ↑Append the task



New registration of Dye
① Select the [Dye Editor] in Tools.

② Press the  to display the dialog 
box.

:edit based on the data of the 
"User Dye" selected in [User Dyes]

③ Enter each items.
○Excitation peak/fFuorescence peak
：Airy Disk
○Automatic emission priority

：refer to next page

④ Press the            button to add “User 
Dye”

⑤ Press the            button to close the 
dialog box.

Absorption curve / Emission curve is 
Imported.
It can be read from a CSV file.
※Curve Import is not required.

61



Emission Priority
■set automatically

V（405）：430-470
C（440）：460-500
B（488）：500-600

  500-580
  500-540

E（514）：530-630
  ：530-580

Y（561）：570-670
  ：570-620

O（594）：610-710
R（640）：650-750

■selecting Ex＋ automatically selects 
the main laser wavelength.

■If you enter  something other 
than the above,
Select "Custome" and enter the key.
→ Please set Wide Band is upper, 
Narrow Band is lower.
(One kind is also acceptable)

In case of Alexa488（preset）
・one color→500-600
・488/640→500-580
・488/568→500-540
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Lambda series(1)
（Ch setting）

＊Before starting the following procedure, 
make adjustments for imaging.
Changing to Lambda mode
① Select “Lambda” in [Mode] in [Detector 

setting] Tool Window
Select Channel
② Press the                      button. The 

[Dye & Detector Select] dialog box 
appears.

③ Press the            button to remove the 
previous setting.

④ Double click and apply the detectors. 
Then, click [OK].

▼Lambda scan with single channel 
：Acquire lambda series with single laser.
Select BSD1
e.g.）Try to separate GFP and Auto FL→ 
excited by LD 488

▼Lambda scan with multi channels 
：Acquire lambda series with multiple lasers. 
e.g.）Try to separate GFP, RFP and Auto 
FL→ excited by LD 488 and 561
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①

③

④

③

④



Lambda series(2)
（LightPath setting）
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⑤ Select [LightPath] in Tool Window.
⑥ Select “LSMScanner” tab at bottom of LightPath tool window.
⑦ Select DMs to guide fluorescent light to detectors.

DMs are selectable by clicking mirror icon.

■Example of single channel.

■Example of 2 channels.

A. Selecting Excitation DM
・To acquire accurate spectrum

→Select BS10/90

・To acquire bright spectrum
→Select DM with same wavelength of

excited lasers.

B. Selecting SDMs
MIRROR→Reflected totally.
GLASS →Transmit
SDM →Reflected particular wavelength.

例）SDM400-540：
Reflected :400nm-540nm
Transmitted :540nm-

A

A

Selected detector on 
previous page

Set mirrors to all 
fluorescence are 
guided to HSD1.

Selected detector on 
previous page

FL are separated by SDM400-540

Shorter than 540nm to BSD1
Longer than 540nm to BSD2

B

B B

B



Lambda series(3)
（Scan setting）

Setting the wavelength
⑦ Set “Band Width” and “Step size” in 

[Spectral setting].

⑧ Set range of lambda series.

Adjusting the live image
⑨ Check the laser to use. Adjust the laser 

power not to 0%.
⑩ Click “Live” to show live image.
⑪ Detection wavelength can be changed for 

each channels.
⑫ Adjust the laser power.

Start acquisition
⑬ Set Z and/or T series when needed.
⑭ Determine the file location and file name.
⑮ Click “LSM Start” .
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⑨

⑦

⑫

⑪

⑧
Linked

⑭

⑮

⑪

⑫

Bandwidth
   Recommend：15nm or so.

When the image is dark, enlarge bandwidth.
Step Size

Recommend :5nm or so.
 Small step size leads to accurate spectrum.

＊You cannot select the laser which includes
±5nm of the excitation wavelength in the
range of each channel.



① Press the  button to switch 
to “Viewer mode”.

② Select [Analysis] in [Tool Window] 
menu. [Analysis] Tool Window appears. 

③ Select [Single process] mode, press the 
[Post Processing] button.

④ Press the            button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item].

⑤ In [Input] in [Input / Output setting], 
select the image for image processing.

⑥ In [Mode] in [processing Property], select 
“Blind Unmixing.

⑦ Set the number of dyes in [Number of 
Spectral Date].

⑧ Press the           button to start the 
fluorescent separation process.

Processing: Unmixing⑴
Blind Unmixing

～by setting the number of dyes~

⑦
⑥

Double click

③②

④

⑤

⑥
⑦

⑧

④
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① Press the  button to switch 
to “Viewer mode”.

② Select [Analysis] in [Tool Window] 
menu. [Analysis] Tool Window appears. 

③ Select [Single process] mode, press the 
[Post Processing] button.

④ Press the            button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item].

⑤ In [Input] in [Input / Output setting], 
select the image for image processing.

⑥ In [Mode] in [processing Property], select 
“Nomal Unmixing” 

⑦ In “!DYE0 Dye Profile Load File”, select the 
first dye profile among from dye data.

⑧ Select the all date.
⑨ Press the           button to start the 

fluorescent separation process.

Processing :Unmixing⑵
Normal Unmixing

～by specifying dye dates~

③②

④

⑤

⑥
⑦

⑧

⑥

④
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Processing : Unmixing⑶
Spectral Image Unmixing

～by specifying dyes~
① Press the  button to switch 

to “Viewer mode”.
② Select [Analysis] in [Tool Window] 

menu. [Analysis] Tool Window appears. 
③ Select [Single process] mode, press the 

[Post Processing] button.

④ Press the            button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item].

⑤ In [Input] in [Input / Output setting], 
select the image for image processing.

⑥ In [Mode] in [processing Property], select 
“Spectral Image Unmixing.

⑦ Specify multiple ROIs on the regions 
where only the target fluorescence dye 
locates to acquire the spectral data for 
image processing.

⑧ In [DYE0 ROI File Name], select the file 
name of the image on which the ROI 
was specified in ⑦.

⑨ In [DYE0 ROI Index], select the first ROI 
specified in ⑦.

⑩ Repeat ⑧⑨ to register all ROIs. Press  
the          button to start the fluorescent 
separation process.

③②

④

⑤

⑥

⑧

⑩

⑧⑨

④

⑦

⑥Select the mode 
⑧select the file

⑥
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Laser power correction（LPM）

Setting of Laser power correction
① Select [Tools] > [Configuration] > [Preference] tab >[LPM] .
② a.  Laser power correction can be used when checked. 

b.  
-Auto: Laser power correction works during scanning. There will be delay before scan starts.
-Manual：Laser power correction will not work automatically. Delay doesn’t exist before scan.
Manual correction available by [One-time laser power calibration] in [Detector Setting].
c.  Set the correction timing on MATL.
-Each group: Correct before each groups in MATL.
-Each area: Correct before each area in MATL.

71

Laser Power Monitor window
① Open by [Tool Window] > [Laser Power 

Monitor]
※Available only administrator.
②
a. Check the all lasers available in LPM.
b. Power check: Log is shown by clicking a.

Power correction: Log is shown when 
correction worked.
c. Ratio or Absolute value
d. Select the laser wavelength.
e. Graph
f. Table of laser power values.
g, Delete value of h and f.
i. CSV output based on selection of b and c. 



■Trouble shooting
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【１】
Q：the acquired image doesn’t appeared in the [Live] tab.
A：confirm if it is checked in [Window]>[Open new Image view].

When hover the mouse over [Open new 
image view], the check is appeared.

【２】
Q：the tab has been minimized or maximized.
A：Double-click the item part of the tab to return to the original.

■Font size setting

1. Open the  [Configuration] ＞
[Preference] 

2. Select the ”Font size” in [Software] .
3. Font size can be adjusted in3 types.
4. Restarting the software.

Font size below cannot be changed
‒ Launch display
‒ Title of the software/tool window
‒ Dialog of Windows
‒ About FV31S-SW dialog
‒ cellSens
‒ On line help

■Reset the layout

1. Click 
[Window] > [Reset Current Layout] 
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■How to create Log file
※When trouble occurred, create log file and make a note when it happened.
※When software is frozen, create log file with remaining software.
※Log file can be created only when logging in with Administrator.

1. Click Start on windows and launch
OLYMPUS cellSens FV > FVLogExporter

2. Click “Next”.
3. Select [For Analysis of problems] , click “Next”

4. Select [Custom] , click “Next” 
Check all then click “Next”

5. Set date and time to include when the trouble occurred then click “Next”
※[Export for last] Collection period by days from the present.
※[Export in range of Date] Collection period by the start and end date.

6. Make sure the file output is Desktop, then click “Next” .
7. Follow the dialogue when it appears, then click “Next”. 
8. Wait until “Finish”  appears, then click “Finish”.

ZIP file will be created on desktop.

③

④
④

⑤



① The auto cleaning

⇒Approx, once a week
If the IX3-SSU is selected as a XY 
stage, the message to select 
whether or not to perform the 
auto-cleaning appears.
Click the [OK] button.

② The manual cleaning

⇒Approx, once a year(depending on frequency of use)

《Cleaning Method》
1）Set the main switch of the controller for ultrasonic stage to OFF.
2) Then, move the stage manually in front/back/right/left directions for 10 
reciprocations each within the full stage movable range one second for one 
reciprocation.

※Pleas don’t move the stage manually except for cleaning.

■Maintenance IX3-SSU
 When using this stage for a long time period, the stage movement may be 

deteriorated due to the wear of the ultrasonic drive unit.
Clean the units as follows on regular basis.
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